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Can	i	transfer	music	from	my	android	phone	to	my	laptop.	How	to	transfer	music	from	my	android	to	my	laptop.	How	to	transfer	music	from	android	to	hp	laptop.	How	to	transfer	music	from	laptop	to	android	phone	wirelessly.	How	to	transfer	music	from	laptop	to	android	tablet.	Transfer	music	from	laptop	to	android	phone.	How	to	transfer	music
from	my	laptop	to	my	android	phone.	How	to	transfer	music	from	laptop	to	android	phone	using	bluetooth.

Connect	the	iPhone	to	the	computer	using	the	USB	cable.	Then,	open	iTunes	on	the	computer.Transfer	automatically:	Select	iPhone	icon	>	Music	>	Sync	Music.Transfer	manually:	Select	Summary	>	Manually	manage	music	and	videos.	This	article	explains	how	to	transfer	music	from	a	computer	to	an	iPhone.	Instructions	apply	to	the	iTunes	app	for
PC	and	Mac.	You	can	also	transfer	music	from	one	iPhone	to	another.	There	are	a	few	things	to	consider	before	transferring	music	to	an	iPhone.	Follow	this	checklist	before	proceeding:	Install	iTunes:	Download	the	latest	version	from	the	iTunes	page	on	Apple's	site.	Keep	iTunes	up-to-date:	Ensure	the	latest	version	of	iTunes	is	installed	on	your
computer	before	plugging	in	your	iPhone.	To	manually	check	for	updates	on	a	Mac,	select	the	Apple	menu,	then	choose	App	Store.	On	a	PC,	select	Help	>	Check	for	Updates.	Once	iTunes	is	up-to-date,	close	the	program.	You	can't	transfer	music	from	an	iPhone	to	a	computer:	iTunes	only	performs	a	one-way	synchronization	to	an	iPhone.	It	doesn't
work	both	ways.	Follow	these	steps	to	connect	your	iPhone	to	your	computer	and	select	it	in	iTunes.	Connect	the	iPhone	to	the	computer	using	a	USB	cable.	Launch	iTunes.	In	the	upper-left	corner	of	the	iTunes	window,	select	the	iPhone	icon,	located	to	the	right	of	the	media	menu.	The	iPhone	appears	in	the	left	iTunes	pane,	under	the	Devices
section.	Select	the	triangle	next	to	the	device	to	expand	the	iPhone	entry	and	select	any	of	the	media	types.	The	easiest	way	to	transfer	music	to	the	iPhone	is	by	using	the	automatic	sync	method.	iTunes	shows	you	how	much	storage	space	is	left	on	the	iPhone.	Check	the	capacity	meter	at	the	bottom	of	the	screen.	On	the	iTunes	window	now	showing
the	device,	select	the	Music	menu	tab	in	the	left	pane.	Select	Sync	Music	to	enable	it.	To	enable	the	transfer	of	all	your	music,	select	Entire	music	library.	If	you	prefer	to	select	only	certain	songs	from	your	iTunes	library,	choose	Selected	playlists,	artists,	albums,	and	genres.	To	specify	the	playlists,	artists,	albums,	and	genres,	scroll	down	and	select
the	media	you	want	to	sync.	To	automatically	sync	music	to	the	iPhone,	select	Apply	to	start	the	transfer	process.	If	a	message	appears	stating	iTunes	can	sync	with	only	one	library	at	a	time,	read	it	carefully	so	you	understand	what	will	happen,	then	select	Sync	and	Replace.	If	you	don't	want	iTunes	to	automatically	transfer	music	to	your	iPhone,	it's
possible	to	configure	the	program	for	manual	syncing.	This	method	offers	more	control	over	which	of	your	iTunes	media	you	want	on	your	iPhone.	Near	the	top	of	the	main	iTunes	screen,	select	Summary	in	the	left	panel.	Select	Manually	manage	music	and	videos	to	enable	this	mode.	Select	Apply	to	save	the	settings.	Select	the	back	arrow	at	the	top
of	iTunes	and	locate	the	Library	section	in	the	left	pane.	Select	Songs.	You	can	also	select	Albums,	Artists	or	Genres.	Drag	and	drop	songs	from	the	main	iTunes	window	to	the	left	pane	where	the	phone	is	listed.	If	you	have	several	songs	you	want	to	sync	at	once,	press	and	hold	Ctrl	or	Command	and	then	select	each	song.	As	an	alternative	to
manually	dragging	songs	to	your	iPhone,	use	iTunes	playlists.	These	are	easy	to	set	up	and	save	time	when	syncing.	If	you	previously	created	iTunes	playlists	you	want	to	sync	to	the	iPhone,	drag	and	drop	the	playlists	onto	the	iPhone	icon	in	the	left	pane.	FAQ	How	do	I	transfer	music	from	iPhone	to	Android?	To	transfer	music	from	iPhone	to	Android,
launch	iTunes	on	the	PC,	select	the	music	you	want	to	transfer,	and	add	it	to	a	new	folder	on	the	PC.	Next,	connect	your	Android	device	to	your	computer,	navigate	to	the	device's	Music	folder,	and	copy	and	paste	the	songs	you	want	to	transfer.	How	do	I	transfer	a	Spotify	playlist	to	Apple	Music?	How	do	I	transfer	music	from	a	computer	to	an	Android
phone?	To	download	music	to	your	Android	phone	from	a	PC,	connect	your	phone	to	the	computer	with	a	USB	cable	and	tap	Allow.	Find	the	songs	on	the	computer	you	want	to	transfer	and	move	them	to	a	new	folder.	Drag	the	music	you	want	to	download	to	the	Android	phone's	music	folder.	Thanks	for	letting	us	know!	Get	the	Latest	Tech	News
Delivered	Every	Day	Subscribe	Tell	us	why!	(Pocket-lint)	-	There	are	a	number	of	Android	pieces	waiting	to	fall	into	place	and	this	leaked,	but	working,	Music	app	seems	to	fit	perfectly	into	the	middle	of	that	puzzle.		The	app	has	the	look	and	feel	of	the	Honeycomb	music	player,	using	the	same	icon	and	essentially	offering	the	same	New	and	Recent
view	that	lets	you	flick	through	your	album	art,	a	little	like	Apple’s	Cover	Flow.		Let’s	be	honest,	the	stock	Android	music	player	is	pretty	bland,	really	only	offering	up	listings	and	playback,	and	Music	3.0	doesn’t	extend	too	much	further	than	that.	You	can	sort	and	search	music	by	the	normal	categories	and	you	get	the	Now	Playing	bar	at	the	bottom
of	most	list-based	pages,	or	an	icon	in	the	top	right-hand	corner	in	the	New	and	Recent	view.	When	a	song	is	playing	you	get	a	little	animated	meter	on	the	right-hand	side,	a	drop-down	menu	offering	options,	like	adding	to	a	playlist.		Best	iPhone	apps	2022:	The	ultimate	guide	By	Maggie	Tillman	·	30	April	2022	These	are	the	absolute	best	iPhone	apps
available	right	now,	from	productivity	apps	to	apps	for	traveling,	reading,	listening	to	music,	and	more.	But	the	interesting	thing	here	is	the	Settings	menu.	This	will	let	you	add	a	streamed	music	account	and	offers	a	range	of	settings	to	control	how	streamed	music	is	handled.	At	the	moment	you	click	on	the	option	to	add	an	account	and	head	through
to	a	blank	screen	and	there	doesn’t	seem	to	be	any	way	to	populate	this	section	of	the	app.	Pocket-lint	The	other	options	offer	up	cache	settings,	Wi-Fi	only	settings	and	a	download	queue.	The	Help	option	at	the	bottom	of	the	page	doesn’t	offer	up	and	suggestions,	just	taking	you	to	a	webpage	that	currently	doesn’t	exist.		Assuming	this	is	a	legitimate
leak	-	rather	than	just	an	enthusiastic	fan’s	recreation	of	the	Honeycomb	app	on	Gingerbread	-	it	seems	to	fit	into	other	nuggets	of	information	we’ve	heard	about	Google	addressing	Music	in	the	future.	It's	not	certain	whether	the	option	to	select	an	account	means	you'll	be	able	to	choose	from	different	streaming	music	services,	or	if	it	just	lets	you
select	the	Google	account	to	access	music	you	have	stored	with	Google,	rather	like	the	Amazon	Cloud	service.	Moving	the	music	player	for	phones	closer	to	the	tablet	version	also	fits	in	with	Google	ascertaining	that	the	two	strands	of	Android	would	come	together.	This	certainly	looks	to	bring	a	uniformity	to	the	mobile	operating	system,	and	we	guess
the	option	would	roll	out	to	Honeycomb	in	an	update.	Pocket-lint	The	app	is	unstable	at	the	moment,	so	we	don’t	recommend	you	use	it	as	your	main	player	-	we	installed	in	on	the	Sony	Ericsson	Xperia	Arc	without	any	problems,	but	it	is	a	little	delicate	and	will	crash	if	you	try	to	access	certain	menus	whilst	playing	music	-	an	option	to	access	“sound
effects”	crashed	the	player	every	time	we	tried	to	take	a	look.		Music	v3	brings	with	it	a	basic	playback	widget,	integration	into	your	notification	bar	(but	doesn’t	offer	any	playback	controls	here)	and	doesn’t	offer	you	any	lock	screen	playback	either.	The	app	come	courtesy	of	Droid	Life,	where	you	can	download	it	for	yourself,	after	seeing	the	story
first	appear	when	a	test	version	of	Android	Market	landed	in	the	laps	of	Tech	From	10.	Writing	by	Chris	Hall.	Ben	Stockton	/	How-To	Geek	iTunes	may	be	dead	on	macOS,	but	it’s	still	alive	and	kicking	on	Windows.	Migrating	away	from	iTunes	is	recommended,	but	if	you	still	want	to	sync	your	existing	iTunes	music	collection	with	Android,	you	can	by
following	these	steps.	You	have	a	few	options	to	choose	from.	You	can	use	the	Apple	Music	app	on	Android,	transfer	your	files	manually,	or	use	third-party	apps	like	doubleTwist	Sync	to	keep	your	music	collection	correctly	synced.	Transfer	iTunes	Music	to	Android	Using	Apple	Music	With	Apple’s	focus	now	on	Apple	Music,	iTunes	is	being	left	behind.
There	isn’t	an	iTunes	app	for	Android,	but	Apple	does	offer	an	Apple	Music	app	on	Android	devices.	You	can	sync	your	iTunes	music	collection	to	Android	using	the	Apple	Music	app.	You	just	have	to	ensure	that	iTunes	on	your	PC	and	the	Apple	Music	app	are	both	signed	in	using	the	same	Apple	ID.	You	also	need	to	be	a	current	Apple	Music
subscriber.	Start	by	opening	iTunes	on	your	PC	and	clicking	Edit	>	Preferences.	In	the	“General”	tab,	make	sure	the	option	for	“iCloud	Music	Library”	is	enabled	and	then	click	“OK”	to	confirm.	If	you	need	to	manually	begin	syncing	songs	to	your	iCloud	storage,	click	File	>	Library	>	Update	iCloud	Music	Library.	You	may	need	to	allow	some	time	for
your	entire	library	to	sync	to	iCloud.	Unfortunately,	iTunes	doesn’t	have	an	obvious	progress	bar	showing	how	long	it	takes	for	this	process	to	complete.	Once	your	iTunes	library	is	fully	synced	to	iCloud,	open	the	Apple	Music	app	on	Android	and	tap	the	“Library”	tab	at	the	bottom.	Your	iTunes	music	collection	will	be	listed	here.	Tap	one	of	the
relevant	tabs	such	as	“Artists”	or	“Songs.”	Press	on	one	of	the	songs	or	artists	to	begin	playing	your	music.	If	you	want	your	music	available	for	offline	playback,	press	the	download	icon	in	the	“Songs”	tab	or	in	individual	“Album”	listings.	Manually	Copy	Your	Music	Files	from	iTunes	to	Android	Unfortunately,	Android	doesn’t	fit	well	into	the	Apple
ecosystem.	While	iTunes	will	sync	music	files	to	iOS	and	iPadOS	devices,	it	won’t	do	the	same	with	Android	devices.	You’ll	need	to	manually	copy	your	music	library	to	Android	instead.	RELATED:	How	to	Copy	Music	to	Your	Android	Phone	There	are	plenty	of	methods	for	doing	this,	including	transferring	files	over	a	direct	USB	connection	between
your	PC	and	Android,	by	using	cloud	storage	like	Google	Drive,	or	by	using	a	flash	drive	with	a	suitable	USB	OTG	adapter.	If	you’re	transferring	your	iTunes	music	to	Android	over	a	direct	USB	connection,	and	assuming	your	iTunes	music	is	being	held	in	the	default	iTunes	music	folder,	open	Windows	File	Explorer	and	head	to	the
“C:\Users\\Music\iTunes\iTunes	Media\”	folder.	Replace	with	your	user	account	folder.	From	here,	select	the	folders	carrying	your	music	files	and	then	right-click	and	hit	“Copy”	or	press	Ctrl+C.	View	your	Android	device	in	Windows	File	Explorer.	Choose	a	suitable	location	on	your	device	and	then	paste	your	copied	iTunes	folders	to	that	location	by
pressing	Ctrl+V	on	your	keyboard	or	right-clicking	and	selecting	the	“Paste”	button.	Once	copied,	use	a	third-party	Android	music	app	to	play	your	music	collection	on	your	Android	device.	Transfer	Your	Music	Using	doubleTwist	Sync	If	you’re	looking	for	an	easier	method	to	transfer	music	files	between	iTunes	and	Android,	an	alternative	to	manual
file	transfer	is	doubleTwist	Sync.	This	software	for	Windows	bridges	the	gap	between	Android	and	iTunes.	It	lets	you	sync	your	music	collection	between	Android	devices	and	iTunes	in	both	directions.	New	music	files	on	your	Android	device	will	sync	to	iTunes	and	vice	versa.	It	will	also	work	over	Wi-Fi,	allowing	you	to	transfer	your	music	files	without
needing	a	direct	USB	connection.	Start	by	downloading	and	installing	the	doubleTwist	software	to	your	PC.	Once	you	open	doubleTwist	Sync,	you’ll	be	asked	to	connect	your	device	over	USB	or	use	the	AirSync	app	to	connect	over	WiFi.	AirSync	isn’t	free,	so	the	cheapest	method	is	to	connect	your	device	using	USB.	Once	you	connect	your	Android
device,	doubleTwist	will	display	used	and	available	space	on	your	device.	Click	the	“Music”	tab	on	the	top	menu.	If	you	want	to	sync	files	from	iTunes	to	Android,	click	the	“Sync	Music”	checkbox.	You’ll	also	need	to	click	the	checkboxes	for	the	listed	subcategories,	including	“Albums”	and	“Artists.”	If	you	also	want	to	sync	files	from	Android	back	to
iTunes,	click	the	“Import	New	Music	and	Playlists”	checkbox.	When	you’re	ready	to	begin	syncing	your	files,	click	the	“Sync	Now”	button.	Your	iTunes	music	files	will	begin	transferring	to	your	Android	device,	while	any	missing	music	files	on	your	Android	device	will	transfer	to	your	PC	to	join	the	rest	of	your	iTunes	collection.	Once	this	process	is
complete,	you	can	then	begin	playing	your	music	on	both	your	PC	and	your	Android	device	using	a	suitable	music	playback	app.	Google	Play	Music	and	YouTube	Music	We’ve	recommended	Google	Play	Music	in	the	past	as	an	option	for	copying	music	to	Android.	Unfortunately,	YouTube	Music	is	now	the	default	music	app	on	Android	devices,	with
Google	Play	Music	soon	to	be	discontinued.	With	that	in	mind,	we	no	longer	recommend	you	use	the	Google	Play	Music	Manager	as	a	way	of	migrating	your	music	files	from	your	PC	to	Android.	At	present,	YouTube	Music	doesn’t	come	with	a	Google	Play	Music	Manager	equivalent.	If	you	want	to	manually	sync	your	iTunes	collection	to	Android,	it’s
better	to	use	the	Apple	Music	app,	transfer	your	files	manually,	or	use	a	third-party	method	like	doubleTwist	instead.
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